
Daily Log Overview
The Daily Log option is a logging program that can be used by registered users of either the K4HAV Win1010 Contest
or Win1010CH County Hunter Program. Its use is optional and may not serve everyone’s purpose, but is included for
those that have requested a general purpose 1010 logging program. The Daily Log feature was added in Win1010
Version 1.3 in January 1999.

Demo Mode
Without a registered Win1010 or Win1010CH UserID file, the Daily Log operates in the Demo Mode. This
mode limits the number of records to 25.

Special Provisions for the “Work the 41’s Numbers” in 2003 Contest
A new contest for the entire year of 2003 has recently been announced. The idea is to work as many of the 10X
numbers which have ‘41’ in the 10X number representing the 40th Anniversity of 10-10. There are slightly over 2800
possible 10X numbers that have the ‘41’ in the 10X number. These should be recorded in the Daily Log. You can view
your progress by going to the Daily Log Print menu and choosing the #7 option. This will display either all those num-
bers in the Daily Log (worked anytime) or just those numbers worked during the year of 2003. Complete details of this
contest was announced in the 1010 Newsletter and will be available on the 1010 web site. This #7 option also has the
option to display for info, the number of 41’s worked in the County Hunter file. A printout can be had in any mode, but
for the contest you should print only the Daily Log display for the year 2003.

Help Files
These Help Files can be printed by going to the Help “File” Menu and choosing Print Topic. Bookmarks can be added
from the Bookmark menu. All Help Files are also available on the HDS Download web page in RTF format, which can
be loaded into Word, WordPad or most other Word Processors.

Features
The Logging Program was designed to handle 22,000 records. All records are stored in memory while the program is in
operation. The log.dat file uses just over 2MB of Windows memory which is fixed, regardless of the number of records
in the file. Even with no records, the 2MB memory is reserved. The name of the data file is Log.Dat and if the 22,000
records are used, then the a portion of the existing Log.Dat file can be transferred to a new file introduced with Version
2.0 – the Daily Log Archive file.  This file has the name Log_Arch.Dat and has a present capacity of 50,000 records.
See the later section on the Archive file for more info.

There is a 30 digit Misc Info field available to add misc information. If this is not enough room, then hitting ALT-N will
activate an extra 255 digit note that will be filed in a separate directory \LogNotes and can be read from the View Menu
or displayed whenever a log record is recalled for display or editing. The file name will be the callsign with the “not” file
extension.

During entry of a log record, the County Hunter data file is searched and a beep and message will be displayed if the
station is a new 10X, Prefix, County or DX Country. To prevent having to duplicate the entry again in the County
Hunter, hitting the F4 key will file the Log QSO into the County Hunter ch95.dat file. If it is a new County, Prefix, VP or
DX Country, then the respective Index files will be updated. If the station’s 10X number has been worked, but he is in a
new county or new prefix due to a vanity call upgrade, then the BAR indicator will be marked “Y” indicating that the
10X has already been entered. The F4 key must be hit before hitting the F1 key to file the Log QSO. There is an option
in the Options in the County Hunter/Daily Log tab to turn off the beep. Also new in Version 1.4a is an option to auto-
matic use the F4 option if a new item is worked. If something is new, then that field will turn to red with white letters
indicating a new 10X, VP, etc. After the auto-F4 is triggered, a display window will show the info transferred into the



County Hunter for about 3 seconds. Any info transferred into the County Hunter can be viewed in the County Hunter by
hitting the ref REF button.

The “*” can be added to a club station call. An example would be KB0ON* which would indicate that this was a club
station. If the club’s entry is in the default contest database, then the club’s info will be entered into the Daily Log
automatically. After one record has been entered, hitting “r” or “R” in the DATE field will repeat the last date. This is
ideal for entering existing records from the past.

Win1010 Version 2.2 adds a new FREQ field for those desiring to use the Daily Log on other bands. If you hit the F1
button to file the record before getting to the FREQ field, then “10” will be used as the default meaning 10 Meters. For
all displays and printout, existing records will have a frequency of zero, but this will be converted to a “10” for printouts
and the View Menu items. When the cursor is in the FREQ field, the allowable frequency or band entries will be dis-
played in the small info window. Once the frequency is changed, this frequency will become the new default, until the
Daily Log Program is restarted and then the default will be 10 Meters. A trap is provided to prevent non-10 meter
records from being exported into the County Hunter.

Main Options Menu Setup
VP Insert on County Hunter Menu: There is an option on the County Hunter Options Menu that also applies to the
Daily Log Program. If you have a VP number, then by checking the “Enable Automatic Insertion of VP Number”, the
VP number will be taken from the VP Database and inserted into the Daily Log. A valid VP QSO will be made if both
parties have a VP number. If you do not have a VP number then you should not check this check box.

There is an option on the CH/DL Options Menu to make the F4 - File to the County Hunter file an automatic
operation if it is a new County, PX, DX, 10X or VP.  This does not file the QSO into the County Hunter if there
is no 10X number, since all records in the County Hunter must have a 10X number.

There is another option in the CH/DL Options Menu that will allow you to start the Daily Log with only the last
50, or 500 QSO’s displayed. If there are a large number of records in the LOG.DAT file, then it will take a while
for the Log Display Window to be populated with all the data. This will speed up that operation. This option
will not take effect until the next time the Daily Log is run. The records appearing can be edited by double-
clicking, but the display will not be updated with the edited data. Hitting the REF button will refresh the screen
and will display the recently edited record.

There is another option in the CH/DL Options Menu to check the FCC database and automatically insert the
City, State and County in the Daily Log data input fields. The default for this is off and must be activiated to be used.

There is an option to start Win1010 in the Daily Log mode on startup.

Before a record is filed, the call and 10X are compared in the 1010 database and if they do not match, then a popup
warning appears stating that fact. Also the call in the 1010 database that matches the 10X is displayed. You can hit
“YES” to go ahead and file the record or hit “NO” to be returned to the 10X field.  A newly issued 10X not in the 1010
database will trigger this warning and it can be ignored. If this 10X verification is not wanted, then there is an option in
the Options CH/DL Menu to turn it off. A similar option exists for the same routine in the County Hunter.

Data Entry
As is the other programs use the Enter key to move from field to field. The mouse can be used later to move the cursor
to edit a field or you can use the combination keys Ctrl-Left or Right Arrow. There are several Function Keys that can
be used during data entry. This log uses some of the same input fields as the County Hunter. As in the other Win1010
modules, you can enter a 10X in the Call field and it will automatically find and enter the call into the Call field.



F1 - File the Log Record: F1 is the only method to file the QSO.

F2 - File the Note: Activate the note field by hitting ALT-N. This can be up to 255 digits.

F3 - Zoom to a Log Record: The record number is displayed on the drag bar on the right hand side of the Log
Window, but this option will allow you to zoom in on a record by typing in the number. The desired record will be
displayed at the top of the Log Window.

F4 - File Log record in County Hunter file: Each Log QSO is checked with the County Hunter file and if a new
10X, new Prefix, new County or new DX Country is noted then a beep and message will be displayed in the small
display window. After all the fields have been completed, this Log QSO can also be filed in the County Hunter by hitting
the F4 key before filing the Log QSO with the F1 key. If you go to the County Hunter to see what you have just filed
there, you will have to hit the Red REF button to Refresh the display. You cannot file a Log QSO into the County
Hunter in the Edit Mode. There is a trap to prevent this. In order for the 10X, VP, etc duping routines to be activated,
you must move from field to field with the ENTER key.

F5 - Edit or display a record: This finds a record either by call or record number. This will find the first occurrence of
the call, but will display other records with the same 10X in the small display screen with the County Hunter file record
number. To edit another record of this call, just hit the F5 key again and enter the CH record number.

F6 - Display All Records: This displays all records with a given call or 10X number. This might be used to find
all QSO’s with a station that has had multiple calls due to upgrading or having a vanity call. Since the 10X
remains the same, searching on a 10X number would find all records, even with different callsigns. This will also search
the Daily Log Archive File (Log_Arch.Dat) if it is being used.

F7 - Zoom to Log QSO by Date: This routine will find the starting record of a date. The date must be entered
in the 8 digit MMDDYYYY format. This routine will find the first record after the search date if a Log QSO
does not exist for the search date. This routine assumes that the records are entered in date order.

F8 - Compare Daily Log to County Hunter: This routine will compare the Daily Log against the County Hunter file
and will display any 10X, VP, County or Prefix that has not been transferred to the County Hunter. A printout is avail-
able and dupes will also be shown, since the Daily Log is not checked for dupes. New in Version 1.8a is the Auto-
Transfer for these records found that are not in the County Hunter. The only records that are not transferred will be the
new counties and prefixes for a record that already has its 10X in the County Hunter. This might be the case of a vanity
call update that resulted in a new prefix or the station was worked in a second county after the first contact had been
recorded into the County Hunter. After the Auto-Transfer routine is run, just rerun the F8 routine again and only display
the “finds”. You may see a few new counties and prefixes. Just make a printout of these and manually enter into the
County Hunter. The Auto-Transfer routine checks the Co and PX index files and updates those files as the new counties
and prefixes are transferred. After the Auto-Transfer is finished, you should rerun the Co, DX and PX Index routines to
recreate these indexes. This will pickup any new DX country that was transferred. Also after this F8 routine is run, the
‘Update Indicators’ on the Reset Indicators menu should be run. NOTE: A Backup of the CH95.DAT file SHOULD
be made before starting this routine. However, during the routine there is an option to make a CH95.DAT backup to a
floppy drive.

F9 - Sort by Date and Rewrite File: This routine will sort all the Daily Log records and rewrite the file in the sorted-
by-date order. You should have a backup before running this routine as the sort is done in memory and then the file is
completely rewritten. If you computer should crash or lose power during this operarion, the log file would be lost.
Version 1.6 adds the time to the date, so that the finished sort is sorted by both date and time.



F10 - Edit or Display a Record by 10X:  Does same thing as F5, but allows to search by 10X number

F11 - Displays all Calls with two 10X Numbers:  This reads the Dupe_10X.TXT file and displays about 117 sorted
calls that have two 10X numbers. When this display is closed there will be another option to display the same list but
sorted by the first 10X number. A call can have two 10X numbers for various reasons. Stations like KB0ON and
N0GIV have a second 10X which belongs the club station which has the same call. Some stations may have forgot they
had a 10X and applied much later for another number. Another possibility is that the first number belonged to a Silent
Key whose call was reissued as a Vanity Call for which the second owner of that call also had a 10X number.

F12 - Edit or Display a Record by 10X:  Displays all the contacts made with unique 10X numbers during the year of
2000. This list is sorted by 10X number. Double-click on the form to clear or to make a printout for the Award. Before
the form is cleared you will be given the option to display all the 10X DXCC Countries Worked during the Year 2000.
Hitting the Blue K button will also clear the display. Version 1.8 adds an ASCII output file for the unique 10X number
display. NOTE: This routine was only used for the year of 2000 and the F12 key will be used for some future need.

Ctrl-G - Validate VP Numbers: This routine is also in the County Hunter and compares the VP numbers against the
VP database and points out potential errors.

Ctrl-L: This routine will chop off a corrupt last part of a Log.DAT file. The newer Ctrl-Y will do the same thing and will
allow the user to pick out the records not to include in the new file.

Ctrl-W: The normal red button “10X” will check the database for the 10X number for a call that is inserted. This
routine will only display the first ‘Hit’ that it comes to. This assumes that each call will have only one 10X number. But
this is not quite true. Several stations have 10X numbers assigned to their calls for a club station. This Ctrl-W routine
will search the entire 1010 database and find the second 10X number. In the event that a 10X number has been as-
signed two or three VP numbers, these duplicates VP’s will also be displayed. Also if the first 10X number for a call
belongs to a Silent Key and the new holder of the call also has a 10X then both will be shown as in the case of
K6ZPW. The original K6ZPW (now a SK) had 10X-91 whereas the present holder of the K6ZPW call has 10X-
70183.

Ctrl-Y: This routine will aid in fixing a corrupt Daily Log Log.DAT file. It will allow you to reconstruct the corrupt file
using the good record numbers. For example: if records 3001 to 3010 were bad and you had 4000 total records, you
could rewrite the file using records number 1 to 3000 and the rerun the routine to write the records 3011 to 4000. The
new file will be named Log.NEW and can be manually renamed or use the renaming routine in the Ctrl-Y sequence.
This same routine also works for the County Hunter CH95.DAT file. Before Version 1.8, the program would not finish
loading the records if a bad record was encountered, but Version 1.8 adds some error routines that will allow you to
resume after each bad record or give you the option to just abort. After the file is finished populating the log window,
you can scroll down the log to find the bad records. The record number will be given in the error control routine so this
should make it easy. Needless to say, a backup of the old Log.DAT file should be made and there is provisions in the
Ctrl-Y routine to make a backup on a floppy disk.

There is no call or 10X dupe checking, therefore stations can be entered as often as desired; however, during the period
of the year 2000, there is a date checking routine to make sure a station is not worked twice in the same day as per the
rules of the 2000 in 2000 Contest. The Y2K dupe checking can be turned off in the CH/DL Options Menu.

Daily Log Archive File
A new feature in Version 2.0 is the Daily Log Archive File. Two stations recently hit the 20,000 record limit with the
original Daily Log and this maximum record limit was extended to 22,000 as a temporary fix. A new “Overflow” or



Archive Daily Log file can be created by going to the Daily Log Utilities Menu under the Utilities button at the top of the
screen. The menu options are:

1. Create/Add to Archive File: This will allow the user to specify the record range of the Daily Log file to be trans-
ferred to the Archive file. In every case, the first record transferred will the be first record in the Daily Log and the last
record will be the one specified in the popup box. For example, if you have 20,000 records in your Daily Log and you
specify 12000, then the records 1-12000 will be transferred to the Log_Arch.Dat file and 8000 will remain in the Daily
Log file. As your Daily Log file builds back up you can then use this option again to transfer more Daily Log records to
the Archive file  This routine will create (or add to) the Archive file by reading the specified records from the Log.Dat
file. When finished with the Archive file, the program will then create a new file named Log.New from the balance of the
Daily Log file. Then the original Log.Dat file will be deleted and the Log.New file will be renamed Log.Dat. At that time
the data in the resulting new smaller Log.Dat file will be read into memory. Since the original Log.Dat file will be deleted,
for data safety reasons, you SHOULD always have a backup of the original file by using one of the methods below or
another method of your choice. After the transfer is completed, options 3 and 4 below can be used to look at the new
files. The Archive Daily Log file has a present capacity of 50,000.

2. Delete Range of Archive File: This routine has not been completed and may be added at a later date if needed.

3. Display Archive File: This will display the Log_Arch.Dat file. The number of records in this file will be shown in the
title of this option. Before the file is created it will have a zero length. This is the only means available to display the
Archive file. Only the basic info is displayed.

4. Display Current Log: This will display the Log.Dat file. The number of records in this file will be shown in the title
of this option.

5. Backup to Floppy: This will backup the Log.Dat file and also the Log_Arch.Dat file if it exists to a floppy disk - one
at a time. A standard 1.44MB floppy will hold about 13,700 Daily Log records, so if you have more than this, you will
need to use a compression program such as WinZip or one of the methods below. Each file has its own backup option
so you can use two floppy disks if the files will fit.

6. Backup to Backup Folder: This will backup the Log.Dat file and also the Log_Arch.Dat file if it exists to the default
Win1010 backup folder — \Win1010\Backup. This routine requires that this folder already exist as would normally be
the case if you have a large number of records in your Daily Log.

7. Backup to Zip Drive: This will backup the Log.Dat file and also the Log_Arch.Dat file if it exists to the root direc-
tory of a Zip Drive or another hard drive partition. You will have a popup window asking for the Drive letter of the drive
you wish to use.

Several stations have indicated that they would transfer their old Daily Log info to the Archive file at the beginning of
each new year so that their Daily Log will reflect only the current year. Others will probably max out the existing 22000
limit of the Daily Log before transferring records to the Archive file. The use of the Archive file is only necessary when
you hit the 22000 maximum limit of the Daily Log records. At some point in the future, this maximum limit may also be
expanded to 30000 or more depending on the Windows operating system and the availability of cheap RAM Memory.

How To Delete a Record
A new feature in the Version 1.4d is the Delete feautre. When editing a record (by double-clicking on a record) you will
see a blue DELETE button on the lower left side of the screen. Clicking this button will change the Call to “DELETED”.
After all the calls have been marked “Deleted”, then you can go to the Utility Menu and run the “Remove Deleted



Records in Daily Log” and the Daily Log file (log.dat) will be rewritten minus these “Deleted” records. Since this
completely rewrites the log.dat file, it would be a good idea to have a backup of the log.dat file, in case a power failure
or glitch happened during the rewrite procedure.

Cross-linked Log File
One station had a cross-linked log.dat file with about 350 good records and then a bunch of garbage at the end of the
file. This garbage caused a runtime error when it was read in. He emailed me his log.dat file and I wrote a short routine
that reads only the good records and rewrites the file. I have put this routine into the program in the event anyone has
this problem. An error routine will catch this error and exit the file read routine. You can look at the log display to see
what the last good record was and use this record in the FixLog Routine. This routine is run by hitting Control-L while in
the Daily Log program. In Version 1.8 another similar routine was added that will let you rewrite either the County
Hunter or Daily Log file in ranges. It is activated by hitting Control-Y.

Backups
There is a combination Backup/Restore Menu in the Certificate Chaser – Red Button #10. Also many of the routines
which rewrites or modifies the CH or DL file will also have an option to make a backup to a floppy disk. Please do not
only have one backup and overwrite it each time. Several stations have overwrote their only good backup with bad
data. The more backups you have – the better.

Print-Outs
The Log Print Menu is on the File Menu in the upper top left of your screen. Several print-out and ASCII options are
available: NOTE: These printout do not access the Daily Log Archive (Log_Arch.Dat) file if it is being used.

1. Print All Records: This starts at the beginning and prints to the end. If there is a misc info field, then this 30 digit
message will be on the second line. There will be a total of 85 lines on a page. If none of the records have a misc info,
then there will be 85 records to a page or if every record has the misc info, then there will be about 43 QSO’s per
printed page. The printout is designed to allow a 3 ring hole punch to have room, if desired to keep logs in a note book.
During this printout you will be given an option to make an ADIF output file of all the Daily Log records. This file will be
named DailyLog.ADI and will be in the Win1010 folder.

2. Print a Range of Records: This is the print option that you will use most of the time. You will be prompted for the
starting record number and then the ending number. Traps are included to make sure valid record numbers are entered
in the proper order. Even if you want a total printout, it would be advisable to do it in smaller ranges. However, if you
wanted to stop the printout, you could always remove all the paper from the printer and then you would get an error,
stopping the print with an option to cancel the print job. Version 1.8 adds an ASCII output file option to this Print
Option. Version 1.8a also added a comma delimited ASCII output file option.

3. Print a Range of Dates: This will allow you to print all records between two dates. If you only want one date, then
use the same date for both the starting and ending dates. There is also an option to make an ASCII file without printing
on paper.

On the HP-890 test printer, a font size of 7 points was required to make all the log info fit on a page. There is an option
on the Log Print Menu to change the font to either 6 or 8 points. 7 Points is the default setting and will be the default
starting font size on the next running of the Log Print Menu.

There is a check box to print in the normal mode or the Y2K mode for the 2000 in 2000 Contest. The Y2K mode only
works in the Print Option #2 (Print a Range of Records). This print routine only prints the QSO number (starting with 1
in the printout), the date, call and 10X. This print option will remain after the Y2K contest for anyone desiring this
compact printout. Since it prints by a range of record numbers, it can also be adapted to print all records by using the



first and last record number as starting and ending points.  Likewise, for printing a range of dates, just enter the record
number for the date you wish to start with.

Note: The printout for the “Work 2000 Different 10X numbers during 2000” is activated by hitting the F12 key. This
displays the list and then by double-clicking on the display, you will have the option to make a printout.

4. Make Comma Delimited ASCII File of Unique 10X Numbers in Daily Log File: This option can be used to
make an ASCII file that can be imported into other programs. This file would be of interest to Win1010 users that only
used the Daily Log and then decided to transfer everything over to the County Hunter Program. There is a Comma
Delimite ASCII import routine in the Certificate Chaser “File” Menu that will allow importing into the County Hunter
Program. Since the County Hunter requires a valid 10X number, non 10X records will not be exported.

5. Make Comma Delimited ASCII File of Complete Daily Log File: This option will output every Daily Log
record to the ASCII file.

6. Print All Records - One Mode Only: This option will print all records in the Daily Log for one mode only. This will
be good to find all your CW or PSK contacts.

7. Print Range of Records - One Band Only: This option will create an ADIF file, Tabbed or Comma-Delimited
ASCII file, or make a printout of a range of records. If all the records are desired, then begin with “1” and end with the
total number of records which will be displayed. The filenames will be displayed on a popup window. Each file is
overwritten, so if a file is to be saved, then it should be renamed with the Windows Explorer.

8. Work the Numbers 2002 Display/Printout: This option will display all the 10X numbers with ‘40’ in the number.
This 2002 contest is also mentioned on page one of this Help file. The Printout will be in two columns of 80 each for a
total of 160 records per page. The display/printout is duped and sorted by 10X number.

NOTE: The special Y2K Contest printout is retained and can be used if desired. It prints a range of basic info in
multiple columns. There may be a need sometime for a condensed printout with just the basic info.

Updates
Program updates can be downloaded free of charge at the http://hds.net/win1010dl.htm web page.  For those not on
the Internet or without friends on the Internet, updates will be furnished by U.S. Mail for $10 which will include a CD
with the latest Win1010 full Program and FCC database and other databases. After installing the full program, updating
will consist of installing a small file on the order of 500K. The large Microsoft supporting files only have to be installed
once. Just the updated Win1010 program file and other databases that are updated will be available for $1.00 for a
floppy disk ($2.00 for DX).


